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These release notes highlight new functionality, enhancements, software and hardware dependencies, and 

include upgrade instructions for the NetVanta Unified Communications product family.  This document is to be 

used in conjunction with product documentation and training for the preparation of new and existing software 

installations and is intended for technical professionals who are providing support services for NetVanta Unified 

Communications products. 

For general product information, please visit ADTRAN’s website at http://www.adtran.com. 

CAUTION:  It is strongly recommended that the contents of this document be reviewed before any 
installation or upgrade, no matter how familiar the installer is with the product, to ensure that 
current installation and upgrade procedures are followed. These procedures could change from 
release to release, including maintenance releases. Failure to follow the upgrade procedures in this 
document could result in non-operational systems. 

1 Summary of Changes 

This section summarizes new functionality introduced in this NetVanta UC Server release, along with issues 

resolved in each release and any release-specific actions that are required as part of upgrading. Each maintenance 

release is identified separately. More detailed descriptions for major new functionality follow in Section 2, New 

Functionality Details. Internal tracking numbers are noted (for example, [1234]). 

For newly introduced functionality and issues resolved in previous major releases, please consult the release notes 

or product documentation for the respective releases.  

Where functionality or issues resolved do not apply to products in the product family, the applicable products are 

noted (for example, ECS, BAS). 

NOTE:  Be sure to review all upgrade actions for all releases between your current release and the release and 

your upgrade. Subsections of the sections below identify required actions, including information about client 

upgrades. 

1.1 Release 4.5.2 

Release 4.5.2 is a maintenance release of the NetVanta UC Server product line that provides support for Microsoft 

Exchange Server 2010 and updated firmware for snom telephone terminals, and adds support for the snom MP 

phone terminal. Additional fixes are also included. 

1.1.1 New Functionality 

The new functionality introduced in this release includes: 

 Customer specific configuration files are now supported for ADTRAN IP700 Series phone terminals 

[8732]   ECS, BCS  

 Added support for snom MP phone terminals [8916]   ECS, BCS 

 Updated snom firmware to 8.2.29 [8915]   ECS, BCS  

 Support for Microsoft Exchange Server 2010 (requires up-to-date MAPI connector) [8790] 

1.1.2 Behavioral Changes 

This section documents changes that affect operational behavior or installation procedures. The following 

changes have been introduced in this release: 

http://www.adtran.com/
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 Priority values for identities and PBX have been reversed (lower values are higher priority). This makes 

these priority values consistent with industry standards and within the product. Existing values are 

automatically pivoted around the default value (100). Values previously larger than 199 could cause 

problems and values are encouraged to be in the range 0-199. [8857]  ECS, BCS 

 Microsoft Exchange Server mailbox monitoring is now enabled by default on new installs [8917] 

 Hold music has been changed to ensure customers have license-free hold music [8823]  ECS, BCS 

1.1.3 Issues Resolved 

Tracking # Summary 

8364 When Microsoft Exchange Server 2007 or 2010 is detected, experimental UM integration 
functionality is enabled by default. This is no longer enabled by default. 

8412 During initial user import or addition in the Server Configuration Wizard, users could automatically 

become selected even when no data is entered for a user. 

8527 Various help file updates. 

8808 Default Aastra telephone terminal RTP packet size not interoperable with some phone terminals. 

Defaults changed to more typical industry standard of 20 milliseconds.   ECS, BCS  

8817 Firewall exception not added for API Service, causing click-to-dial clients to be unable to connect 

to Application Server.   ECS, BCS 

8826 Audio recorded for SIP-based PBX integrations could be clipped or louder than expected.  

8827 The Outdial service element incorrectly exits via the otherwise pin if the number to call is an empty 

string retrieved from an SQL database. 

8835 When using the Active Directory Users and Computer snap in to remove users, user data might not 

always be removed properly. 

8842 ACD data recording has incorrect values related to transferred calls. Calls appear to be longer than 

they really are.  ECS, BCS 

8871 FTP permissions and firewall exclusions fail to be configured on Window Server 2008 R2 when 

configuring Polycom phone terminals.   ECS, BCS  

8872 IIS configuration for Polycom FTP incorrectly uses HTTP root folder instead of FTP root folder on 

Windows Server 2008 R2.   ECS, BCS 

8876 snom telephones unable to be used with click-to-dial functionality.   ECS, BCS  

8900 When running the Server Configuration Wizard on a system with UAC enabled, user is not 

prompted for elevation to administrator. As a result, the Server Configuration Wizard tasks could 

fail. 

8909 Microsoft Outlook hangs when trying to send email from an email address within a Microsoft Word 

document when click-to-dial functionality installed.   ECS, BCS 

8910 Call drops while attempting to add users to distribution list using the TUI. 

1.1.4 Client Upgrade Actions 

Client software does NOT have to be upgraded; however, any user who wants to pick up help files changes 

[8527] should update their client software. 
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Administrative users who want to pick up changes [8364], [8835], [8857] or [8917] must install the updated 

client software. 

1.1.5 Other Upgrade Actions 

For upgrades of the ECS and BAS products, scripts MUST be run before and after upgrading to properly upgrade 

phone configuration files. Any customizations to phone configuration files must be manually re-applied using the 

information and backups made by the scripts. Refer to Section 4.2.2, Upgrading NetVanta UC Server from any 4.x.x 

Release, for more information on this procedure. 

CAUTION:  This is a critical step for any customers using snom telephone terminals. Failure to 
correctly follow this procedure will result in snom telephone terminals failing to load new 
configuration information. 

1.2 Release 4.5.1 

Release 4.5.1 is a maintenance release of the NetVanta UC Server product line that enhances click-to-dial 

functionality, adds PBX grouping and prioritization features, adds support for ADTRAN Total Access 900(e) Series 

IP business gateways, and adds support for Polycom SoundPoint IP 321 and 331 phone terminals. Additional fixes 

are also included. 

1.2.1 New Functionality 

The new functionality introduced in this release includes: 

 PBX s can be grouped and prioritized; user identities  can be prioritized [8686] 

 Click-to-dial supports monitoring clipboard for phone numbers [8472]    ECS, BCS 

 Support for ADTRAN Total Access 900(e) Series IP business gateways  (T1/PRI)[8745]   ECS, BAS 

 Support for Polycom SoundPoint IP 321 and 331 phone terminals[8648]   ECS, BAS 

1.2.2 Issues Resolved 

Tracking # Summary 

8359 Audio is squelched at the end of some audio prompts when calling from an ITSP via an InGate 

firewall into the Application Server. 

8621 Deployment of NetVanta UC Client components using Active Directory GPO deployment takes 

roughly 1 hour per client system. 

8623 Right click menu on NetVanta ucCompanion system tray icon does not always show the menu. 

8643 User data source does not show up related to a shared service on a ring group identity. 

8658 Outlook plug-in causes RPC issues when repeatedly accessing click-to-dial menus on email 

messages (especially with large numbers of contacts in a users contact database). 

8660 In medium to large size Active Directory installations (>1000 users), or where users do not have a 

Active Directory Global Catalog Server on the local LAN (for example, VPN, remote site), click-to-

dial phone number look up could be slow and cause delays when displaying contact and email 

message context menus in Outlook.  ECS, BCS  

8710 Outdial.exe is missing from client installation. 
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1.2.3 Client Upgrade Actions 

Client software does NOT have to be upgraded, however, users using click-to-dial functionality, Outlook 2003 or 

Outlook 2007 SHOULD update their client software to install enhancements and fixes in the Outlook plug-ins. 

1.2.4 Other Upgrade Actions 

For upgrades of the ECS and BAS products, scripts MUST be run before and after upgrading to properly upgrade 

phone configuration files. Any customizations to phone configuration files must be manually re-applied using the 

information and backups made by the scripts. Refer to Section 4.2.2, Upgrading NetVanta UC Server from any 4.x.x 

Release, for more information on this procedure. 

1.3 Release 4.5.0 

Release 4.5.0 is a major release of NetVanta UC Server that introduces support for Click-to-Dial and the ADTRAN 

NetVanta 7000 Series IP PBXs. Additional feature improvements and fixes are also included. Product downloads 

have been reduced in size by excluding product documentation, Microsoft .NET Framework redistributables, or 

Adobe Reader redistributable. 

This release also introduces new product names and branding. Refer to Section 2.4, ADTRAN Product Rebranding 

for more information. 

1.3.1 New Functionality 

The new functionality introduced in this release includes: 

 Click-to-dial for NetVanta Enterprise Communications Server and NetVanta Business Communications 

System [8466]   ECS, BCS 

 Support for ADTRAN NetVanta 7000 Series IP PBXs [8492]   UCS, BCS 

 Outbound dialing improvements [8415] 

 Telephone terminal support for ADTRAN IP700 Series phones
1
 [8615]  ECS, BAS 

1.3.2 Issues Resolved 

Tracking # Summary 

8246 More than one Generic PBX (via Gateway) cannot easily be added. 

8486 SIP telephone’s MWI might not turn off immediately after registration.  ECS, BAS 

8512 MWI might not turn off when quickly reading a newly delivered message in Outlook. 

8581 Cannot set password and have it take effect for Merlin Magix CTI link after initial configuration. 

8592 First Time Access Wizard always runs in NetVanta UC Client for IMAP users even though all IMAP 

configuration values have been configured. 

Note that all fixes included in 4.4.1, 4.4.2, and 4.4.3 are included in release 4.5.0. Please consult the release notes 

for 4.4.3 for details on issues resolved in those releases. 

                                                                        
1
 In order for ADTRAN IP Phones to correctly display the time in the local time zone, the phones must have their 

phone configuration file templates modified according to the phone documentation. In particular the GmtOffset 
parameter must be configured. Please refer to http://kb.adtran.com/article.asp?article=2254&p=2 for more 
details. 

http://kb.adtran.com/article.asp?article=2254&p=2
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1.3.3 Upgrade Requirements 

Prior to upgrading an existing NetVanta UC Server system, be sure that the hardware platform and operating 

system software meet the minimum requirements; otherwise, you will not be able to upgrade the software. 

Ensure that both client and server requirements are met. Refer to Section 0, CAUTION:  Failure to preserve 

installed software release media properly could result in the inability to rebuild a failed server at a later date. 

Copies of noncurrent software versions might not be readily available from ADTRAN Technical Support or your 

reseller causing delays to support technicians rebuilding failed servers. 

System Requirements, for more information. 

Both client and server components now require Microsoft .NET Framework 3.5 SP1 to be installed on target 

systems. 

1.3.4 Client Upgrade Actions 

Client software MUST be upgraded for all users of the NetVanta UC Server system. More information on client 

deployment techniques, including automated deployment can be found in Section 4.3, Installing or Upgrading 

NetVanta UC Client Software. 

1.3.5 Other Upgrade Actions 

Any scripts using the OutDial.exe command line program MUST be updated to accommodate new command line 

syntax. Run OutDial -? to obtain usage information. 

For upgrades of the ECS and BAS products, scripts MUST be run before and after upgrading to properly upgrade 

phone configuration files. Any customizations to phone configuration files must be manually re-applied using the 

information and backups made by the scripts. Refer to Section 4.2.2, Upgrading NetVanta UC Server from any 4.x.x 

Release, for more information on this procedure. 

RestartOverrides.cfg MUST be updated on the NetVanta UC Server to include updated settings provided in 

RestartOverrides.cfg.original. 

CAUTION:  Backup procedures have changed from releases prior to 4.3.3. The SQL database 
instance for NetVanta UC Server MUST be backed up to ensure proper recovery of failed systems. 
For instructions on backup and restore procedures, refer to the Planning and Deployment Guide, 
available online at http://kb.adtran.com/. Please adjust backup procedures accordingly. Failure to do 
so could result in data loss or extended system outages in the case of hardware or software failures. 

CAUTION:  Due to fixes related to MWI behavioral inconsistencies introduced in release 4.3.1, when 
a system is upgraded to 4.5.x from a release prior to 4.3.1, users’s could experience a change in 
behavior of the MWI if their preferences (or system-wide settings) for MWI behavior are not set as 
they would prefer. Please ensure that system defaults are correctly set and that users are aware of 
how to change their MWI preferences. 

2 New Functionality Details 

This section describes more significant portions of the new functionality introduced in this NetVanta UC Server 

release.  

Where functionality or issues resolved do not apply to products in the product family, the applicable products are 

noted. 

http://kb.adtran.com/
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2.1 Click-to-Dial 

Click-to-dial enables users of NetVanta Business Communications Systems and NetVanta Enterprise 

Communications Server to initiate a call by clicking on a contact or an email message within Microsoft Outlook 

2003 and Microsoft Outlook 2007. 

NetVanta ucCompanion provides a system tray icon that enables the user to select an identity, enter a telephone 

number for dialing, launch NetVanta UC Client, and configure NetVanta ucCompanion. NetVanta ucCompanion 

also monitors the clipboard for telephone numbers allowing users to easily dial a phone number from any 

application that supports copying of text. To use, in any application, select some text containing phone numbers 

and use the appropriate command (for example, Ctrl+C) to copy the selected text to the clipboard. NetVanta 

ucCompanion will pop up a window allowing you to dial the phone number with one click. 

Contact systems supported: 

 Windows Active Directory 

 Outlook 2003 and Outlook 2007 Personal Contacts. The user’s personal contacts will be matched against 

each of the email recipients addressed in the email. If a match exists, the corresponding name and 

telephone numbers will be presented for the user to select. 

If Microsoft Outlook 2003 or 2007 is installed, a plug-in will be installed that allows the user to initiate a call on 

their configured telephone from: 

1. Outlook Contacts 

2. An email message 

 Right click on email message in email preview.  (Outlook 2007 only) 

 Call button within  an email message 

2.2 Support for ADTRAN NetVanta 7000 Series IP PBX 

The ADTRAN NetVanta 7000 Series has been added to the list of communications systems that can be added to 

NetVanta UC Server. Centralized messaging of NetVanta 7000 Series PBXs is accomplished by adding multiple 

instances of NetVanta communications systems. Centralized messaging also applies to any number of PBXs.  

The NetVanta 7000 Series integration also includes click-to-dial functionality. 

2.3 Outbound Dialing Enhancements 

Outbound dialing has been enhanced to include better support for working with external applications. Notable 

improvements include: 

1. Unique reference numbers are given to each outbound dialing request. 

2. Added time windows support (named time periods and time zone definitions) to ensure that outbound 

dialing notifications only occur during specified time windows. 

3. Added a prioritization parameter to higher priority scheduled outbound dialing notifications to be dialed 

ahead of lower priority notifications. 

For a complete list of parameters supported by the OutDial command line program, run outdial.exe /? from 

the command line. 
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2.4 ADTRAN Product Rebranding 

Objectworld branding has been replaced with ADTRAN branding. UC Server product editions have been replaced 

with distinct products. Refer to the table below for details. 

Old Product Edition Name New  Product Name 

Standard Edition NetVanta Unified Communications Server when sold for use with a third-

party PBX. 

NetVanta Business Communications System when bundled with 

NetVanta 7000 Series. 

SIP Edition NetVanta Enterprise Communications Server 

CEBP Edition NetVanta Business Application Server 

3 Installation Requirements 

This section describes the environmental prerequisites required for the correct operation of NetVanta UC Server, 

including operating systems, server/client platforms, messaging servers, and mail clients. In addition, it describes 

any steps required prior to installing NetVanta UC Server software, including obtaining the license key. 

3.1 Preserving Installation and Upgrade Media 

If physical installation media (a CD or DVD) was received, please store this media in a safe place so that the 

software can be reinstalled at a later date if necessary (for example, in the event of a hardware failure). 

If the software was downloaded, please ensure  that a separate copy of the installation media is made to CD or 

DVD and this media is stored in a safe place so that the software can be reinstalled at a later date if necessary (for 

example, in the event of a hardware failure). Do not store the downloaded media on the same physical disks as 

the operational server as a single disk failure could cause this media to be permanently lost. 

Ensure that if software upgrades are performed, new versions are also stored on separate media in a safe place. 

Support personal could require a copy of the installation media to reinstall software at a later date. 

CAUTION:  Failure to preserve installed software release media properly could result in the inability 
to rebuild a failed server at a later date. Copies of noncurrent software versions might not be readily 
available from ADTRAN Technical Support or your reseller causing delays to support technicians 
rebuilding failed servers. 

3.2 System Requirements 

3.2.1 Server Components 

This section describes the required operating systems, hardware requirements, and third-party integration 

platforms for the NetVanta UC Server server components. This applies to both upgrades and new installations. If 

existing server hardware does not meet these requirements, it must be upgraded or migrated to new hardware 

prior to upgrading to this release of NetVanta UC Server. 
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3.2.1.1 Operating Systems 

The NetVanta UC Server server components support the following Microsoft® Windows™ Operating Systems: 

 Microsoft® Windows™ Server 2008 R2 (x64) 

o Foundation, Standard, Enterprise, and Data Center editions are supported. 

o Deployment on Server Core or Hyper-V is not supported. 

 Microsoft® Windows Small Business Server 2008 (x64) 

The recommended deployment for optimal performance and reliability is to install NetVanta UC 
Server on the additional Windows Server 2008 license that is part of the Premium Edition of 
Windows Small Business Server 2008. NetVanta UC Server can also be installed on the Windows 
Small Business Server 2008 platform with suitable hardware. Refer to Section 3.2.1.2, Hardware 
Requirements, for more information. 

 Microsoft® Windows Essential Business Server 2008 (x86, x64) 

NetVanta UC Server should be deployed on the additional Window Server 2008 license that is part of 
the Premium Edition of Windows Essential Business Server. Do not install NetVanta UC Server on 
the Security Server. It is not recommended to install NetVanta UC Server on either the Management 
Server or the Messaging Server. 

 Microsoft® Windows™ Server 2008 (x86, x64) 

o Foundation, Standard, Enterprise, and Data Center editions are supported. 

o Deployment on Server Core or Hyper-V is not supported. 

 Microsoft® Windows™ Server 2003 R2 SP1, SP2 (x86) 

 Microsoft® Windows™ Server 2003 SP1, SP2 (x86) 

 Microsoft® Windows™ Small Business Server 2003 SP1 (x86) 

 Microsoft® Windows™ XP SP2, SP3 (Professional) (x86) (Warning: Refer to known limitation [8282]) 

Other software platforms are not supported. 

Installation of the server components into a virtualization environment (Virtual Server, Hyper-V, Virtual PC, 

VMware, Virtual Box, etc.) is not supported in production deployments. Due to the real-time nature of 

telecommunications, audio problems will be experienced in these environments. 

ADTRAN recommends using a server operating system for all installations of NetVanta UC Server. While the 

client platforms mentioned above (such as, Microsoft® Windows™ XP) are supported, they are designed by 

Microsoft for desktop use not server use. Known limitation [8282] is also known to affect the reliability of 

Windows XP installations and could cause system outages in certain circumstances. Refer to Section 7, Known 

Software Limitations, for more details. 

CAUTION:  At this point in time, many third-party drivers and applications do not yet support 
Windows Server 2008 and derived platforms (SBS 2008, EBS 2008). When using TAPI integrations, 
or other integrations requiring use of CTI drivers, please review driver documentation for those 
products BEFORE proceeding with plans to use Windows Server 2008 as the server platform for 
those deployments. 

3.2.1.2 Hardware Requirements 

To install NetVanta UC Server, the server hardware platform must meet the minimum requirements in the 

following table. The minimum requirements are for a minimal installation. The recommended requirements are a 

guideline for more robust, reliable, and future-proofed systems.  

Product engineering guidelines and recommendations should be consulted and followed for anything other than a 

minimal installation (for example, installations with more than 25 users). Sizing of the server hardware is 
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dependent on the number of users, the traffic levels, and application services used. Selection of hardware should 

also take into account such things as redundant power supplies, uninterruptable power supplies (UPSs), and 

redundant disk arrays (for example, RAID) so that the end users needs and expectations are met, along with any 

future growth requirements.  

Consult TN102 - Hardware Platform Recommendations and the Planning and Deployment Guide, available online at 

http://kb.adtran.com, for more information on correctly selecting the hardware. 

Hardware 

Component 

Minimum Recommended 

Processor Intel Pentium Dual-Core (E2140) Intel Xeon Quad-Core (E5310) 

RAM 2 GB 

4 GB on Windows Small Business Server 2003 

6 GB on Windows Small Business Server 2008 

4 GB 

6 GB on Windows Small Business Server 2008 

Disk space 80 GB (usable space) 

7200 RPM 

146 GB (usable space) 

SAS – RAID 1 or RAID 5 

3.2.2 Mail/Messaging Servers for Unified Messaging 

NetVanta UC Server supports the following email servers for Unified Messaging: 

 Microsoft® Exchange™ Server 2000, 2003 SP1 (requires service pack 1 or later), 2007, 2010 

 IBM® Domino™ Server 6.0.x, 6.5.x, 7.0, 8.0 (via IMAP) 

 Google Mail (via IMAP using stunnel) 

 University of Washington IMAPd 

 Any 100 percent compliant IMAP4rev1 (RFC 3501) message store (different servers could require different 

query optimization techniques – consult product documentation for query optimization technique 

determination procedures) 

Integration with Microsoft® Exchange™ Server requires a MAPI connector to be installed on the NetVanta UC 

Server platform. The supported MAPI connectors, of which only one should be installed on the server platform, 

are the following: 

 Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 (Version: 6.5.8165.0, 2010-

Apr-28 – older versions are not compatible with all platforms).This is available for download free of 

charge from: http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-

0a110307611e&displaylang=en 

 Microsoft® Outlook™ 2003 SP3 

CAUTION:  Failure to use SP3 with Microsoft® Outlook™ 2003 will cause unreliable integration with 
Microsoft® Exchange™ Server and could cause system outages. 

 Microsoft® Outlook™ 2007 SP1 (SP2 is not supported) 

CAUTION:  Outlook 2007 SP2 (recently released) is not compatible as a server MAPI connector with 
UC Server and installing it will cause NetVanta UC Server to be unable to connect to Exchange 
Server. 

http://kb.adtran.com/
http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-0a110307611e&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-0a110307611e&displaylang=en
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ADTRAN recommends using Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 instead 

of Microsoft Outlook and strongly encourages all customers to switch to this MAPI connector instead of Outlook. 

The benefits of doing this are as follows: 

 No Outlook license is required for the NetVanta UC Server system. The MAPI/CDO package is available 

at no charge. 

 The MAPI/CDO package is a minimal installation that requires fewer Microsoft Updates. 

 This component is designed and provided by Microsoft explicitly for the purpose of allowing applications 

such as NetVanta UC Server to access Exchange Server and does not include many of the client-side 

nuances of Outlook versions of MAPI. 

On Exchange Server 2003, additional steps are required after following the manual integration instructions in 

Appendix A of the Configuration Guide: 

Delegate Exchange View Only Administrators control to the NetVanta UC Server service account: 

1. Open Exchange System Manager on an Exchange Server in the enterprise, or an administrative workstation. 

2. Select the enterprise level object (the root object in the tree). 

3. Select Delegate control… from the Action menu. This will open the Exchange Administration Delegation 

Wizard. 

4. Click Next. 

5. In the Users or Groups page of the wizard, click Add to open the Delegate Control dialog box. 

6. Select the role Exchange View Only Administrators from the list of roles. 

7. Click Browse… and select the service account used by NetVanta UC Server for Exchange Server and network 

integration. 

8. Click OK in the Select Users, Computers or Groups dialog box. 

9. Click OK in the Delegate Control dialog box. 

10. Click Next in the Users or Groups page of the Exchange Administration Delegation Wizard. 

11. Click Finish to complete and close the wizard. 

3.2.3 Client Components 

This section describes the required operating systems and hardware requirements for the NetVanta UC Server 

client components. Most installations will deploy client software to some or all of the end users of the system. 

Some installations do not require deployment of the client software depending on how NetVanta UC Server will 

be used. 

3.2.3.1 Operating Systems 

The NetVanta UC Server client components (NetVanta UC Client, NetVanta ucCompanion, and NetVanta 

ucCompanion - Live Attendant) support the following Microsoft® Windows™ Operating Systems: 

 Microsoft® Windows™ 7 (Professional, Ultimate, or Enterprise Editions) (x86, x64) 

 Microsoft® Windows™ Vista, SP1, SP2 (Business, Ultimate, or Enterprise Editions) (x86, x64) 

 Microsoft® Windows™ XP SP2, SP3 (Professional or Tablet PC Editions) (x86) 

 Microsoft® Windows™ Server 2008 R2 (x64) 

 Microsoft® Windows™ Server 2008 (x86, x64) 

 Microsoft® Windows™ Server 2003 R2, SP2 (x86) 

 Microsoft® Windows™ Server 2003 SP1, SP2 (x86) 

Other software platforms are not supported. 
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3.2.3.2 Prerequisite Components 

Client components now require Microsoft .NET Framework 3.5 SP1 to be installed on target systems. In addition, 

for some components additional Microsoft redistributable components will be installed by the client installer. 

3.2.3.3 Hardware Requirements 

To install NetVanta UC client, the platform must meet the following minimum requirements for the specified 

Microsoft Windows operating systems listed below.  

Client XP, Server 2003 Vista, Windows 7, Server 2008, 

Server 2008 R2 

Processor x86 compatible processor 

600 MHz or higher 

x86 or x64 compatible processor 

1 GHz 

RAM 256 MB 1 GB 

Free Disk space 500 MB 500 MB 

Video Super VGA (800 x 600) or higher 

resolution video adapter and monitor 

Support for DirectX 9 graphics with: 

 WDDM Driver 

 Minimum 128 MB graphics 

memory  

 Pixel Shader 2.0 in hardware 

 32 bits per pixel 

3.2.3.4 Email Clients for Unified Messaging 

NetVanta UC Client integrates with the following email clients for Unified Messaging: 

 Microsoft® Outlook™ 2000, 2002/XP, 2003 SP3, 2007 

 IBM® Lotus Notes™ 6.0x, 6.5.x, 7.0, 8.0 

3.3 Product Licensing (License Key) 

All NetVanta UC Server products must be correctly licensed to operate. The license key obtained from ADTRAN is 

specific to each installation and defines the exact functionality licensed by the end user for their installation. 

3.3.1 New Installs 

When installing NetVanta UC Server for the first time, you must obtain a license key to install and activate the 

software. 

3.3.2 Upgrades 

To upgrade NetVanta UC Server from a previous major or minor release, you must obtain a new license key prior 

to beginning the upgrade.  The existing license key, found in the License Information dialog box in the 

administrative NetVanta UC Client must be updated to the new license key prior to beginning the upgrade.  After 

the new key is installed, you can continue to upgrade the server software. You do not need a new license key for 

maintenance (patch or dot) releases. 

Upgrade license keys are only available to customers who have an active Software Assurance subscription. 
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3.3.3 Obtaining a New License Key 

To obtain a new or upgrade a license key, fill out a license key request in the UC Tools area of the ADTRAN 

website (http://www.adtran.com/uctools).  

Note: Please allow enough time to obtain the license key – at least one (1) business day should be allocated to 

ensure the license key is obtained before installation or upgrade.  

You will need the following information: 

1. Contact information 

2. Product Keys  

 New installs: available from materials that shipped with the product. 

 Upgrades: available for a user with Administrator privileges. From NetVanta UC Client, select the Help 

menu > License Information. 

3. Purchase key 

 New installs: available from materials that shipped with the product. 

 Upgrades are available:  

 For a user with Administration privileges: From within NetVanta UC Client, select the Help > License 

Information. Click Modify license. 

 From the Product Licensing Wizard dialog box from Step 1 of NetVanta UC Server Configuration 

Wizard. 

4. Machine ID  

 New installs: available from the Product Licensing Wizard dialog box of Step 1 of the NetVanta UC Server 

Configuration Wizard. 

 Upgrades are available:  

 For a user with Administration privileges: From NetVanta UC Client, select the Help > License 

Information. Click Modify license. 

 From the Product Licensing Wizard dialog box of Step 1 of NetVanta UC Server Configuration 

Wizard. 

5. Platform specifications (CPU speed, RAM, and server OS) – available from the System control panel in the 

Windows Control Panel. 

6. Product version and edition you will be installing or upgrading – available from the materials shipped with the 

product. 

7. Message store type (Microsoft Exchange Server, Lotus Domino/Notes, IMAP4, or local machine) and version. 

8. Legacy PBX interconnection, if applicable: PBX type, firmware version. 

3.4 Prerequisite Components 

NetVanta UC Server requires that prerequisite components be installed prior to installing the NetVanta UC Server 

software. The installer will detect which components are missing from the system and prompt accordingly.  Some 

of the prerequisite components are included on the distribution media and can be installed automatically by the 

installer. However, others must be obtained directly from the vendor. Links to the relevant web-sites for any 

components that require downloading will be provided by the installer. 

Not all prerequisites are required on all operating systems; specifics are noted below. Except where indicated, the 

prerequisites are installed automatically by the installer. The prerequisite components are: 

 Microsoft Windows Server 2003 Service Pack 1 Administration Tools Pack (download link provided in 

installer) [Windows XP only] 

 Microsoft .NET Framework 3.5 SP1 (download link provided in installer) 

 Visual Studio 2005 SP1 Redistributable Files 

http://www.adtran.com/uctools
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 ADTRAN Software Logging Diagnostic Tools 

 Windows Server 2008 Enhanced Desktop Feature (a reboot is required after installation) [Windows 

Server 2008-based systems only] 

 Microsoft SQL Server 2005 Express Edition (SP3 version is installed, older service packs are supported 

except on some OS platforms) 

CAUTION:  NetVanta UC Server will only work correctly with the version of Microsoft SQL Server 
that is provided on the distribution media. Other instances of SQL Server cannot be used by 
NetVanta UC Server. 

4 Installation and Upgrade Instructions 

Please review Section 3, Installation Requirements, before proceeding with this section. It contains important 

information about product licensing, system requirements, and the versions of required external software 

components.  

CAUTION:  Failure to comply with the installation requirements, or properly follow the installation 
or upgrade instructions will result in an inoperable or poorly performing system. 

4.1 New Install of NetVanta UC Server 

This section contains an overview of the installation for NetVanta UC Server; for detailed installation procedures 

consult the Installation Guide applicable to your NetVanta Unified Communications product. To facilitate 

installation and configuration, have the following reference material available during installation: 

 Release Notes (this document) 

 Planning and Deployment Guide 

 Installation Guide 

 NetVanta Unified Communications Server Presence and Control Components Guide (for use with NetVanta 

ucCompanion - Live Attendant) 

 Configuration Guide 

 Administrator Manual 

To ensure that all the required information is available during the installation and configuration process, it is 

recommended that the Planning and Deployment Guide Worksheet be completed. 

4.1.1 Installing the Server Software 

The installation software will automatically verify the prerequisites for software installation.  Make sure that you 

run the installation from a Windows logon that has the ability to install software on the NetVanta UC Server 

system (for example, Administrator privileges). 

To install NetVanta UC Server: 

1. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the 

NetVanta UC Server CD-ROM was shipped to you, go to Step b. 

a. Unzip the contents of the file you downloaded to a temporary folder on NetVanta UC Server (you 

will need to provide a location and name for the folder).  Start the installation by double clicking on 

CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). 

b. Insert the NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN 

NetVanta Unified Communications CD menu will appear. 
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Install the applications to the NetVanta UC Server platform by clicking on the Install Server button on the 

installation screen and following the prompts on the subsequent screens. 

a. Ensure that all prerequisites are installed. These will vary depending upon your platform and the 

components purchased, such as the Presence and Control components and the Windows 2003 

Server Administration Tool Pack. The NetVanta UC Server Installation Wizard will ensure that all 

prerequisite components are installed before proceeding. 

b. After all the prerequisite components are successfully installed, the wizard allows you to install the 

NetVanta UC Server software. 

2. Run the NetVanta UC Server Configuration Wizard, Configure UC Server.  The NetVanta UC Server 

Configuration Wizard allows you to specify server properties such as message store, NetVanta UC Server 

administrator password, PBX information, and dialing properties.  The wizard guides you through the server 

configuration process. The wizard does most of the configuration tasks automatically, however, site specific 

information about the network and server needs to be entered at various steps. 

3. When installing NetVanta UC Server for the first time, you must obtain a license key. To obtain a license key, 

please refer to Section 3.3, Product Licensing (License Key). 

4.1.2 Installing the Client Software 

In order for NetVanta UC Server users to take full advantage of its functionality, client software should be 

deployed to their desktop or laptop computers. Refer to Section 4.3, Installing or Upgrading NetVanta UC Client 

Software, for installation options and procedures. 

4.2 Upgrading/Cross-grading NetVanta UC Server 

CAUTION:  Backup procedures have changed from previous releases. For instructions on backup 
and restore procedures, refer to the Planning and Delpoyment Guide, available online at 
http://kb.adtran.com, and adjust backup procedures accordingly. Failure to do so could result in 
data loss or extended system outages in the case of hardware or software failures. 

4.2.1 Upgrade/Cross-grade Matrix 

The following table describes which versions of NetVanta UC Server can be upgraded to newer versions and which 

versions of CallAttendant Office can be cross-graded to NetVanta UC Server. 

To 

 

From 

4.0.x
 

(UC Server) 

4.5.x 

(NetVanta UC Server) 

Pre 3.2.x (CallAttendant Office) Unsupported via direct upgrade 
– upgrade to 3.2.x first, then to 

4.0.x 

Unsupported via direct upgrade – 
upgrade to 3.2.x first, then to 

4.0.x 

3.2.x  (CallAttendant Office) √ 
Unsupported via direct upgrade – 

upgrade to 4.0.x first 

4.0.x (CallAttendant Office) √ √ 

4.2.x (CallAttendant Office)  √ 

4.0.x (UC Server)  √ 

4.1.x (UC Server)  √ 

http://kb.adtran.com/
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4.2.x (UC Server)  √ 

4.3.x (UC Server)  √ 

4.4.x (UC Server)  √ 

4.5.x (NetVanta UC Server)  √ 

In order to upgrade from older versions, interim upgrade steps must be followed. Refer to the applicable section 

below for more details. 

4.2.2 Upgrading NetVanta UC Server from any 4.x.x Release 

CAUTION:  The existing version of NetVanta UC Server must NOT be uninstalled prior to 
upgrading. The installation process requires that the existing implementation be available in order 
to perform the upgrade correctly. 

The following is a summary of the upgrade procedure from any NetVanta UC Server 4.x.x release; refer to the 

Installation Guide applicable to your NetVanta Unified Communications product, available online at 

http://kb.adtran.com, for detailed instructions on installing this component.  

CAUTION:  Failure to follow the steps below, exactly as described, could result in a system that does 
not upgrade or operate correctly after upgrade. 

Perform the following steps: 

1. If performing a major or minor upgrade, obtain a new license key. Please refer to the instructions in Section 

3.3, Product Licensing (License Key). 

2. Backup the NetVanta UC Server. For instructions on backup and restore procedures, refer to the Planning and 

Deployment Guide applicable to your NetVanta Unified Communications product, available online at 

http://kb.adtran.com/. Backing up will preserve the following data: 

a. Users (greetings, services, announcements) 

b. Port configuration 

c. Attendant data 

d. System configuration 

e. Routing data 

f. Telephone data 

g. Gateway data 

h. PBX configuration data 

CAUTION:  Failure to backup the data according to these instructions and the Technical Note will 
result in the inability to restore the system to the original configuration should the upgrade process 
be unsuccessful or aborted. Always back the system up prior to upgrading. 

3. If a new license key was obtained in Step 1, modify the current license key using the following procedure: 

a. Open NetVanta UC Client using the current installed product version and log in as a user with 

administrative privileges. 

b. Select License Information… under the Help Menu on the main toolbar. 

c. Click the Modify license… button to open the Modify License dialog box. 

d. Enter the new license key in the space provided. 

e. Click OK to close the Modify License Dialog box. 

f. Click Close to close the License Information Dialog box. 

http://kb.adtran.com/
http://kb.adtran.com/


NetVanta Unified Communications 

 
19 

g. Close NetVanta UC Client by clicking the top right corner x icon or selecting Close from the File menu. 

4. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the 

NetVanta UC Server CD-ROM was shipped to you, go to Step b. 

a. Unzip the contents of the file you downloaded to a temporary folder on the server computer (you will 

need to provide a location and name for the folder). 

b.  Insert the NetVanta UC Server CD-ROM. The CAAutoRun application will start, and the ADTRAN 

NetVanta Unified Communications CD menu will appear – leave this open for now, you will use it later. 

5. For ECS and BAS product variants, run the Pre-Update.bat script file as follows: 

a. Click the Start menu and select Run… 

b. Type cmd.exe and click OK to open a command prompt window 

NOTE: On systems with User Account Control (UAC) enabled, such as Windows Server 2008 R2, you 

must start the command prompt window as Administrator. To do this, instead of Step a and Step b 

above, do the following: 

1. Click on the Start menu. 

2. Type cmd.exe in the search bar. (If classic start menu is enabled, locate Command Prompt under 

All Programs | Accessories instead.) 

3. Right click on cmd.exe in search results (or Command Prompt in the menu), and select Run as 

administrator. 

4. Accept the UAC prompt to elevate the command prompt to administrative privileges. 

 

c. Navigate to the script folder on the installation media using the CD command. This is located in the 

Utility\Scripts subfolder of the installation media. 

Example: CD /d C:\NetVantaUCServerInstallMedia\Utility\Scripts 

d. Run the Pre-Update.bat script, supplying any appropriate parameters relevant to your installation: 

Syntax: Pre-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder] 

 If your NetVanta UC Server installation is not located at C:\Program 

Files\ADTRAN\NetVanta UC Server\, you must specify the location of the PhoneTypes 

system data folder as shown in the example below. 

 If backups should be written to a location other than C:\Backup\PhoneTypes, then you 

must specify a backup folder as shown in the example below. 

 The /? option provides help on the script; the /V option provides more detailed output and 

logging. 

Example: Pre-Update.bat "C:\Program Files\ADTRAN\NetVanta UC 
Server\Data\System\PhoneTypes\" "C:\Backup\PhoneTypes\" 

e. When the script prompts you to continue, confirm the information displayed, type Y, and then press 

Enter. 

f. Examine the output of the script to ensure it ran correctly. The output is placed in a file called 

Pre-Log.txt in the backup location. The default backup location is C:\Backup\PhoneTypes. 

g. Leave the command window open because it will be used later. 

6. The ADTRAN NetVanta UC Server Application Services service could be unable to be started during the 

upgrade due expiry of the service account password. This can also occur spontaneously on some Windows XP 

installations or in networks where account passwords have to be changed regularly, but will not be detected 

until the machine is restarted or the ADTRAN NetVanta UC Server Application Services service is restarted. 

Be sure to have the service account password accessible in order to reset it immediately. 

To verify that the service account password has not expired, do the following: 

a. Open the Services administration tool from Start > Control Panel > Administrative Tools. 



NetVanta Unified Communications 

 
20 

b. Locate the service named ADTRAN NetVanta UC Server Application Services. 

c. Right click on the service, and select Restart from the context menu. 

d. If the service fails to start, right click on the service, and select Properties from the content menu. 

e. Select the Log On tab. Re-enter the service account password in the provided fields and click OK. 

f. Attempt to start the service again by right clicking on the service, and selecting Start from the context 

menu. If the service again fails to start, verify that the service account is operating correctly and is not 

locked out. 

Failure to perform this step will cause the install to fail with a 1920 error if there is a problem with the service 

account or its password. This can be corrected by following the same steps while the 1920 error is displayed. 

Do not cancel the 1920 error dialog box because it will fail to upgrade and your system will have to be 

restored from backups. When you have corrected the service account password, click Retry in the 1920 error 

dialog box. 

7. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the 

NetVanta UC Server CD-ROM was shipped to you, go to Step b. 

a. Locate the temporary folder where you extracted the files in a previous step. Start the upgrade by double 

clicking on CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). 

b. From the ADTRAN NetVanta Unified Communications CD Menu (opened when the CD was inserted in a 

previous step), click the Install Server button to prepare the NetVanta UC Server upgrade. 

8. On an upgrade from previous releases, you could be required to install or update prerequisite components. 

Click on the Verify or automatically install remaining components button to proceed. Some components 

might require downloading from the vendor’s websites. 

9. Adding the NetVanta UC Server Presence and Control Components: 

a. If you are using the NetVanta Unified Communications Server product variant, or if you do not plan on 

using NetVanta ucCompanion - Live Attendant: 

 Disable the following option: Install Presence Components. 

 Click Next. 

b. If you are upgrading the Presence and Control Components from a 4.2.x, 4.3.x, 4.4.x or 4.5.x version: 

 Click the Install Presence Components button in the Preparing UC Server Installation dialog box. 

 Click Install on the Resuming the ADTRAN NetVanta UC Server Presence and Control 

Components Setup Wizard screen. 

 Click Finish when complete. 

 Click Yes when prompted to restart the system for the configuration changes to take effect. 

c. If you are upgrading the NetVanta UC Server Presence and Control Components from a 4.1 Trial version: 

 Click the Install Presence Components button in the Preparing UC Server Installation dialog box. 

 Click Next on the welcome page of the ADTRAN UC Server Presence and Control Components 

Setup wizard and follow the prompts on subsequent screens until finished. Consult the NetVanta 

Unified Communications Server Presence and Control Components Guide for additional installation 

documentation. 

10. Upgrading the NetVanta UC Server.  

a. If upgrading from 4.2.x, 4.3.x, 4.4.x or 4.5.x: 

 The ADTRAN NetVanta Unified Communications Server Setup welcome page will appear briefly 

as the upgrade does various checks on the system. 

 Click the Install button when the page titled Resuming the ADTRAN NetVanta Unified 

Communications Server Setup Wizard appears and follow the prompts to complete the upgrade. 

 Click the Finish button to close the setup wizard and return to the Preparing NetVanta UC Server 

Installation dialog box. 

b. If upgrading from 4.0.x or 4.1.x Trial: 
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 Install the server application to the NetVanta UC Server platform by clicking on the Install UC 

Server button.  

 The ADTRAN NetVanta Unified Communications Server Setup welcome page will appear briefly 

as the upgrade does various system checks.  

 Click the Install button when the page titled Resuming the ADTRAN NetVanta Unified 

Communications Server Setup Wizard appears. 

 Continue clicking the prompts to complete the upgrade. 

 Click the Finish button to return to the Preparing UC Server Installation dialog box.  

11. Click the Configure UC Server button to launch the NetVanta UC Server Configuration Wizard. 

NOTE:  If all the steps in the server configuration were completed prior to the upgrade, you will be presented with 

three options (Change Service Account, Users, and Phone Types).  You could be required to perform the first 

option, Change Service Account to reset the service account to what was configured prior to the upgrade. 

12. In an upgrade from 4.0.x you need to complete Gateway configuration in the NetVanta UC Server 

Configuration Wizard then reset the service account: 

a. Click on the Configure UC Server to launch the NetVanta UC Server Configuration Wizard. 

b. When prompted to login, login as a user with NetVanta UC Server administrative privileges. 

c. Complete the Gateways portion of the wizard. (Select Next, select None, then Next, then click Finish to 

close the Gateway wizard). 

d. Click Exit to close the NetVanta UC Server Configuration Wizard. 

e. Click the Configure UC Server button in the Preparing UC Server Installation dialog box. 

f. Login as a user with NetVanta UC Server administrative privileges when prompted. 

g. Click on the Change Service Account option and proceed to configure the service account.  

h. Select the service account that was configured prior to the upgrade. 

i. Click Close to exit the NetVanta UC Server Configuration Wizard. 

j. Click Close to exit the Preparing UC Server Installation. 

13. For ECS and BAS product variants, run the Post-Update.bat script file as follows: 

a. Locate the command window opened in Step 5. 

b. Run the Post-Update.bat script, supplying any appropriate parameters relevant to your installation: 

Syntax: Post-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder] 

 If your UC Server installation is not located at C:\Program Files\ADTRAN\NetVanta UC 

Server\, you must specify the location of the PhoneTypes system data folder as shown 

below in the example. 

 If backups were written to a location other than C:\Backup\PhoneTypes, then you must 

specify the same backup folder as specified in Step 5. 

 The /? option provides help on the script; the /V option provides more detailed output and 

logging. 

Example: Post-Update.bat "C:\Program Files\ADTRAN\NetVanta UC 
Server\Data\System\PhoneTypes\" "C:\Backup\PhoneTypes\" 

c. When the script prompts you to continue, confirm the information displayed, type Y, and then press 

Enter. 

d. Examine the output of the script to ensure it ran correctly. The output is placed in a file called 

Post-Log.txt in the backup location, which defaults to C:\Backup\PhoneTypes. 

e. When the script completes, it will indicate if any site-specific customizations have been made. Details of 

the customizations will be output to a file called FileComparison.txt in the backup location. The 

default backup location is C:\Backup\PhoneTypes. 
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f. Re-apply site-specific customizations to the relevant phone configuration files. Refer to phone vendor 

documentation if needed. Once any customizations have been re-applied, restart the ADTRAN NetVanta 

UC Server Application Services service using the Services administrative tool. 

14. Update the RestartOverrides.cfg file (located in …\NetVanta UC Server\Data\System\Recovery\) 

according to the following conditions: 

a. If manual changes have been made to this file, then you must manually copy any entries from 

RestartOverrides.cfg.original to RestartOverrides.cfg that are not present in the latter file. 

b. If no manual changes were made to this file, then replace the contents of RestartOverrides.cfg with 

the contents of RestartOverrides.cfg.original.  It is not necessary to restart the ADTRAN 

NetVanta UC Server Application Services service. However, if the file has been appended to instead of 

being replaced, then the application service must be restarted for the changes to take effect. 

15. If Install Presence Components was selected in Step 9, you will be required to configure these components 

at this time. Please consult the NetVanta Unified Communications Server Presence and Control Components 

Guide for configuration documentation. If this is an upgrade from 4.2.x, 4.3.x, 4.4.x or 4.5.x, then the 

NetVanta UC Server Presence and Control Components could have already been configured. 

16. For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions, please 

refer to Section 3.7, Configuring Services, of the Installation Guide. 

17. For ECS and BAS product variants, re-apply phone configurations to all phones in the system as follows: 

a. Open NetVanta UC Client and log in as a user with administrative privileges. 

b. Click on the Administration navigation bar. 

c. Click on the Phones folder in the Administration navigation bar. 

d. In the contents pane, select all phones by clicking on the first phone, then pressing Shift-Ctrl-End on the 

keyboard. All phones should now be selected. 

e. Right click on one of the selected phones, and select Reload Configuration from the menu. This will 

cause all phone configuration files to be regenerated and phones to reload their configuration data 

(rebooting most phone types). 

4.2.3 Cross-grading from CallAttendant Office Server 4.0.x/4.2.x to NetVanta UC Server 

CAUTION:  The existing version of CallAttendant Office must NOT be uninstalled prior to cross-
grading. The installation process requires that the existing implementation be available in order to 
perform the upgrade correctly. 

The following is a summary of the procedure for cross-grading your CallAttendant Office release 4.0.x/4.2.x 

software, please consult the Installation Guide for detailed instructions on installing the NetVanta UC Server 

component.  If the CallAttendant Office software is currently below the 4.0 Software versions, you must first 

upgrade to Release 4.0.x version.  

This upgrade will take significantly longer as the NetVanta UC Server installation program will make a complete 

copy of the data for the upgraded installation. For large installations where voice and fax messages are stored on 

locally, it can take one to two hours to copy the data during the upgrade. Do not cancel the upgrade during this 

process. As a result, this upgrade will require at least twice as much disk space as the Data folder occupies in order 

to perform the upgrade. 

Prior to upgrading to release 4.0.x, do the following: 

1. Backup the CallAttendant Office using the instructions found in TN071 – Backup and Restore Procedures for 

CallAttendant Office, available online at http://kb.adtran.com, to preserve the following data: 

a. Users (greetings, services, announcements) 

b. Port configuration 

c. Attendant data 

d. System configuration 

e. Routing data 

f. Telephone data 

http://kb.adtran.com/
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g. Gateway data 

CAUTION:  Failure to backup the data according to these instructions and the Technical Note will 
result in the inability to restore the system to the original configuration should the upgrade process 
be unsuccessful or aborted. Always back the system up prior to upgrading. 

2. Record the CallAttendant Office service account username and password. This can be done using the Services 

Control Panel application. Select the CallAttendant Office service and record the username. The password 

must already be known because it cannot be viewed in the Services Control Panel. 

3. You must have an up-to-date license key to support the latest release of CallAttendant Office 4.0.x and 

NetVanta UC Server (in some circumstances, you could receive two license keys that will be used to support 

the upgrade). To obtain a new license key, please refer Section 3.3.3, Obtaining a New License Key. 

4. Ensure that you enter the new license key in the CallAttendant Office administrator application (Help > 

License Information) menu prior to upgrading the software. 

CAUTION:  If an existing PBX is being replaced with NetVanta Enterprise Communications Server, 
please contact support@adtran.com for additional instructions. 

To install NetVanta UC Server: 

1. Rename all of the configuration files in the .\Data\System by appending .old to the existing filename: 

Example: C:\Program Files\Objectworld\CallAttendant Office 

Server\Data\System\DefinityPBXDefinition.cfg to DefinityPBXDefinition.cfg.old 

2. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the 

NetVanta UC Server CD-ROM was shipped to you, go to Step b. 

a. Unzip the contents of the file you downloaded to a temporary folder on the server computer (you will 

need to provide a location and name for the folder).  Start the installation by double clicking on 

CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). Preserve a 

copy of the installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade 

Media. 

b. Insert the NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN NetVanta 

Unified Communications CD menu will appear. 

3. If you plan on using NetVanta ucCompanion – Live Attendant, install or update the NetVanta UC Server 

Presence and Control components at this time. Consult the NetVanta UC Server Presence and Control 

Components Guide for installation documentation, which is provided on the distribution media. 

4. Install the server applications to the NetVanta UC Server platform by clicking on the Install UC Server 

buttons on the NetVanta UC Server installation screen and following the prompts on the subsequent screens 

until finished. 

5. For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions, please 

refer to Section 3.7, Configuring Services, of the Installation Guide. 

6. Once the installation has completed, select the Configure UC Server button to run the Server Configuration 

Wizard, but do not add anything if it has already been configured. From the set of options, at a minimum, 

complete the following tasks: 

a. Enter the NetVanta UC Server license key to enable SIP functionality. 

b. Configure the Windows Network Integration and select from one of the following: 

i. If the service account was previously configured for Local System account, you must create a 

Windows account on the local machine.  Operating the Application Services service on the Local 

System account is no longer supported. 

ii. If the service account was previously configured with a Windows Active Directory™ account, then 

configure the Existing Service Account. 

mailto:support@adtran.com
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7. Open the Windows Services application and ensure that the ADTRAN NetVanta UC Server Application 

Services service is set to start automatically. Note, you might have to refresh (F5) the services application in 

order to get a current view of the status. From the Windows Services Applications, start the ADTRAN 

NetVanta UC Server Application Services service if it is not already started. 

8. Complete the remaining steps in the NetVanta UC Server Configuration Wizard. If appropriate, make any 

additional configuration changes required, such as adding NetVanta Enterprise Communications Server as a 

new communication system, adding new phone types or new gateways. 

4.2.4 Cross-grading from CallAttendant Office Server 3.2.x to NetVanta UC Server (all editions) 

NOTE:  It is not possible to upgrade directly from 3.x to 4.2 and later releases (Refer to Section 4.2.1, Upgrade/Cross-

grade Matrix). An upgrade from CallAttendant Office 3.x to CallAttendant Office 4.0.x must be performed as an 

intermediate step. Once this is complete, you can upgrade to the latest NetVanta UC Server 4.x release. 

To upgrade 3.x to 4.0.x: 

1. Backup the CallAttendant Office using the instructions found in TN071 – Backup and Restore Procedures for 

CallAttendant Office, available online at http://kb.adtran.com, to preserve the following data: 

a. Users (greetings, services, announcements) 

b. Port configuration 

c. Attendant data 

d. System configuration 

e. Routing data 

f. Telephone data 

g. Gateway data 

CAUTION:  Failure to backup the data according to these instructions and the Technical Note will 
result in the inability to restore the system to the original configuration should the upgrade process 
be unsuccessful or aborted. Always back the system up prior to upgrading. 

2. Stop the CallAttendant Office Service from the Windows Services application. 

3. Rename the following files: 

a. C:\Program Files\Objectworld\CallAttendant Office 

Server\Data\System\Announcements folder to Announcements.old 

b. C:\Program Files\Objectworld\CallAttendant Office 

Server\Data\System\DefinityPBXDefinition.cfg to DefinityPBXDefinition.cfg.old 

4. If the CallAttendant Office software was downloaded from the ADTRAN website, follow Step a. If the 

CallAttendant Office CD-ROM was shipped to you, go to Step b. 

a. Unzip the contents of the file you downloaded to a temporary folder on the CallAttendant Office server 

(you can create a CallAttendant Office folder). Start the installation by double clicking on 

CAAutoRun.exe (the CallAttendant Office installation screen will appear). Preserve a copy of the 

installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade Media. 

b. Insert the CallAttendant Office CD-ROM. The Auto run application will start and the CallAttendant Office 

installation screen will appear. 

5. Install the Server applications to the CallAttendant Office platform by clicking on the Install CallAttendant 

Office Server button on the CallAttendant Office installation screen and following the prompts on the 

subsequent screens until finished. Do not choose to reboot the computer at this point. 

6. Open the Windows Services application and set the CallAttendant Office Service to start automatically. 

NOTE:  You might have to refresh (F5) the Services application in order to get a current view of the status. 

7. From the Windows Services applications, start the CallAttendant Office service. 

8. Convert the system audio.  If the software was upgraded from Release 3.1 or earlier, you must convert the 

audio from the pre-existing 11 kHz-8bit audio format to the newly supported 8 kHz mu-law audio. Although 

http://kb.adtran.com/


NetVanta Unified Communications 

 
25 

the CallAttendant Office server will change the audio format on-the-fly the conversion will introduce latency 

in playing audio files or messages. 

CAUTION:  Ensure that you perform the audio conversion during the maintenance window – 
typically, after normal business hours. 

To perform the audio conversion: 

1. From My Computer, navigate to the C:\Program Files\Objectworld\CallAttendant Office 

Server\Bin directory. 

2. Double-click on the ConvertAudio.exe application. 

4.2.5 Upgrading Client Software 

If anything other than a minor server upgrade has taken place, client software must be updated on end user 

computers; only 4.5.x client software is supported with 4.5.x server software. Refer to Section 4.3, Installing or 

Upgrading NetVanta UC Client Software, for installation options and procedures. 

4.3 Installing or Upgrading NetVanta UC Client Software 

This section documents manual installation procedures, and presents other techniques for automated client 

deployment. 

CAUTION:  Only release 4.5.x NetVanta UC Client software is compatible with NetVanta UC Server 
4.5.x software (the patch revision value ‘x’ does not need to be identical). All incompatible clients 
must be upgraded after the NetVanta UC Server has been upgraded. 

4.3.1 Manual Installation or Upgrade Instructions 

NOTE:  The user installing NetVanta UC Client software MUST have administrative privileges on that desktop 

computer. 

1. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the 

NetVanta UC Server CD-ROM was shipped to you, go to Step b. 

a. Unzip the contents of the file you downloaded to a temporary folder on the desktop computer (you will 

need to provide a location and name for the folder). Start the installation by double clicking on 

CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). Preserve a 

copy of the installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade 

Media. 

b. Insert the NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN NetVanta 

Unified Communications CD menu will appear. 

2. Install the client applications to the client computer by clicking on the Install Client button on the installation 

screen and following the prompts on the subsequent screens. 

CAUTION:  Installing NetVanta UC Client directly on the NetVanta UC Server platform is not 
supported. Ensure that the client is installed on a separate platform meeting the minimum 
requirements. 



NetVanta Unified Communications 

 
26 

4.3.2 Other Techniques for Installing and Upgrading Client Software 

Client software can be deployed using automated techniques including: 

 GPO-based MSI installation. Refer to TN034 - Client Software Installation Guide, available online at 

http://kb.adtran.com, for more information on this option. 

 GPO-based login scripts that invoke either SETUP.EXE or MSIEXEC.EXE with appropriate parameters. 

Prerequisite components must have been previously installed successfully. Consult standard Microsoft 

documentation for more information on those techniques. 

5 Support, Documentation, and Training 

5.1 Support 

Self-service support material can be obtained from the ADTRAN website, http://www.adtran.com/support/, and 

from the ADTRAN Technical Support Knowledge Base, http://kb.adtran.com/. 

Information on product support services can be obtained from the ADTRAN website: 

http://www.adtran.com/support/. 

5.2 Documentation 

Product documentation and additional technical support material can be found on the ADTRAN website, 

http://www.adtran.com/support/, and in the ADTRAN Technical Support Knowledge Base, http://kb.adtran.com/. 

5.3 Training 

Information on current training programs and certifications can be found on the ADTRAN website: 

http://www.adtran.com/training/. 

5.4 Product Downloads and Third-Party Drivers 

Product downloads and third-party drivers and patches are available in the support area of the ADTRAN website: 

http://www.adtran.com/support/. 

6 Third-party Interoperability 

CAUTION:  Currently, some third-party drivers and applications DO NOT yet support Windows 
Server 2008 and derived platforms. When using TAPI integrations, or other integrations requiring 
the use of CTI drivers, please review driver documentation for those products BEFORE proceeding 
with plans to use Windows Server 2008 as the server platform for those deployments. 

Please consult information provided in TN051 – UC Server Interoperable SIP Devices and Services, available online 

at http://kb.adtran.com, for interoperability information related to: 

 SIP telephone terminals 

 SIP soft phones 

 SIP paging speakers, amplifiers and related devices 

 SIP wireless terminals 

http://kb.adtran.com/
http://www.adtran.com/support/
http://kb.adtran.com/
http://www.adtran.com/support/
http://www.adtran.com/support/
http://kb.adtran.com/
http://www.adtran.com/training/
http://www.adtran.com/support/
http://kb.adtran.com/
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 SIP gateways and application layer gateways (ALGs) 

 ITSPs 

Information on PBX integration and software applications is provided below in this document. 

6.1 NetVanta UC Server with a PBX Integration 

6.1.1 Supported Private Branch Exchanges (PBX) 

NetVanta Unified Communications Server has the capability to connect to multiple traditional PBXs and IP PBXs 

while simultaneously supporting SIP services ECS.  NetVanta UC Server can be deployed as a voicemail, unified 

message server, database IVR platform, and fax server behind a traditional PBX while also simultaneously 

supporting SIP telephony ECS.  This provides a useful transition strategy for companies looking to migrate to 

VoIP but who still want to leverage their existing infrastructure.  NetVanta UC Server users who employ a 

traditional PBX for telephony can still take advantage of Active Directory™ integration for user management; the 

telephony features will be managed through their PBX configuration interface. 

NetVanta UC Server integrates with a wide variety of traditional PBX and IP PBXs using Dialogic 1000 and 2000 

Media Gateways. The following PBXs are now supported using the Dialogic Media Gateway: 

 Alcatel Omni PCX 4400 

 Avaya Communications Manager 

 Avaya Definity G3 

 Avaya Legend 

 Avaya Merlin Magix 

 Avaya Partner 

 Ericsson BusinessPhone 

 Ericsson MD110 

 Intecom PointSpan M6880 

 Mitel 3300 

 Mitel SX-2000 

 Mitel SX-200D Family 

 NEC NEAX2400 

 Nortel CS-1000 

 Nortel DMS 10 

 Nortel DMS 100 

 Nortel Meridian 1 

 Phillips Sopho 

 Rolm (Siemens) 8000 

 Rolm (Siemens) 9000 

 Rolm (Siemens) 9751 

 Siemens HiCom 150E 

 Siemens HiCom 300 

 Siemens HiPath 4000 

 Toshiba CTX 

For more specific details on which PBX editions and interfaces are supported, consult the Dialogic Media Gateway 

documentation available from Dialogic’s website: http://www.dialogic.com/support/helpweb/mg/integration.htm. 

NetVanta UC Server also integrates with the PBXs listed in the table below using one of the following techniques: 

 Analog port integration with in-band tones using Dialogic® D/4PCIUF and D/120JST-LS Media Boards 

 Digital set emulation using Dialogic® D/82JCT-U and D/42JCT-U PBX Integration Boards 

 CTI link/analog port integration using Dialogic® D/4PCIUF and D/120JST-LS Media Boards 

 PBX Vendor supplied Microsoft TAPI/WAVE Service Providers 

PBX Vendor/Model Minimum 

Software 

Release 

Technical Note 

(TN) Reference 

Number 

Integration Type Third-Party 

Hardware/Software 

(Recommended) 

Avaya 

Communications 

Manager 

1.0 and above TN016 Digital set emulation: 

- 7434D emulation 

- 8434D emulation 

- 7434ND emulation 

Dialogic 6.0 SU 229 

http://www.dialogic.com/support/helpweb/mg/integration.htm
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PBX Vendor/Model Minimum 

Software 

Release 

Technical Note 

(TN) Reference 

Number 

Integration Type Third-Party 

Hardware/Software 

(Recommended) 

Avaya Definity  

(no CLID) 

6.3 and above TN009 Analog port using mode 

codes; mode code 

option is required 

Dialogic 6.0 SU 229 

Avaya 

Definity/Multi-

Vantage 

(with CLID) 

4.0 and above TN010 

 

Digital set emulation: 

- 7434D emulation 

- 8434D emulation 

- 7434ND (7.5 and above) 

Dialogic 6.0 SU 229 

Avaya IP Office 2.0 and above TN012 CTI link/analog port 

using TAPI 

- IP 400 CTI link  

- IP 400 TAPI-WAVE 

Dialogic 6.0 SU 229 

Avaya Merlin 

Legend 

3.1 and above  Analog port using mode 

codes 

Dialogic 6.0 SU 229 

Avaya Merlin Magix  

(with CLID) 

2.1 and above TN008 Analog port using mode 

codes 

Magix CTI link bundle 

Dialogic 6.0 SU 229 

Avaya Merlin Magix 

(no CLID) 

2.1 and above TN008 CTI link/analog port 

using mode codes 

/TSAPI 

Dialogic 6.0 SU 229 

Avaya Partner ACS 3.0 and above  Analog port using mode 

codes 

Dialogic 6.0 SU 229 

Cisco Call Manager 4.2 TN039 Cisco-supplied Microsoft 

TAPI/WAVE Service 

Provider 

 

Mitel SX200 (family) G1005/LW16 

F41.0.2 

TN011 Analog port using 

enhanced in-band DTMF 

tones 

Dialogic 6.0 SU 229 

Mitel 3300 (IVR only) Any version 

that requires 

ONS voicemail 

support 

 Analog port using  

in-band DTMF tones 

Dialogic 6.0 SU 229 

Nortel Norstar 4.2 and above TN003 Digital set emulation: 

- M7324 set emulation 

Dialogic 5.1.1 with 

PTR.31016 ** 

Generic in-band PBX dependent  Analog port using  

in-band DTMF tones 

Dialogic 6.0 SU 229 

** NetVanta UC Server ONLY supports Dialogic Release 5.1.1 software with PTR.31016 (LIBFAXMT.DLL) for 

Norstar PBXs since the Do Not Disturb feature does not work with Dialogic Release 6.0 for Nortel Norstar PBX. 
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6.1.2 New Installation of Dialogic Software 

To install Dialogic software on the new NetVanta UC Server: 

1. Install the Dialogic System Software compatible with the PBX make and model. 

a. Run SETUP.EXE from Windows Explorer. 

i. When prompted to select features, select Core Runtime Package, select Next. 

ii. When advised that the installation will install third-party software, select Yes. The installation will 

detect and remove any existing Dialogic system software. 

iii. The first stage of the installation will require a reboot. When prompted to restart the system, 

select Yes. 

2. Verify through the Windows Hardware Device Manager that all of the Dialogic cards reside in the Dialogic 

Springware Devices section. 

NOTE:  If any of your cards appear to be improperly configured (for example, caution symbol or otherwise) then 

you will have to update the driver. 

a. To update the driver: 

i. Locate and configure the Dialogic card from Device Manager. 

ii. Select the Driver tab and select Update Driver. 

iii. Choose Search for suitable driver for my device (recommended), and click Next. 

iv. When the driver update locates the Dialogic Card, click Next. 

b. Repeat Step i through Step iv for each Dialogic card that appears improperly installed or configured. 

3. Run Dialogic Configuration Manager (Start > Programs > Dialogic System Release > Configuration Manager 

– DCM. DCM will detect any Dialogic hardware installed on the machine hosting NetVanta UC Server 

software. 

a. Ensure that the board settings match your PBX type. (The default configuration is Nortel Norstar.) 

b. For digital set emulation, open each card and ensure the MISC tab > PBXSwitch parameter is configured 

according to your integration. 

c. Refer to the relevant configuration guide 

4. Configure the Dialogic service to start automatically; Select Settings > System Device Autostart to Start 

System.  It is normal to encounter the error message Failed to set the Device Autostart setting. Requested 

data not found in NCM data storage. 

5. Proceed with NetVanta UC Server installation instructions. 

6. Verify the Dialogic board ordering by running NetVanta UC Client as an administrator and call each port. If 

the ports are not answering in the correct order, switch the Dialogic cables on the back of the machine 

hosting NetVanta UC Server software. 

6.1.3 To upgrade Dialogic software on existing NetVanta UC Server (if required) 

Once you have determined that the Dialogic software version needs to be upgraded then perform the following 

steps: 

1. Remove existing Dialogic system software. 

a. Stop the existing NetVanta UC Server and Dialogic services. 

b. Launch the Microsoft® Windows Service control application (Start > Settings > Control Panel > 

Administrative Tools > Services). 

i. Stop the service labeled ADTRAN NetVanta UC Server Application Services and change the 

service Startup type from Automatic to Manual. 

ii. Stop the service labeled Dialogic System Service. 

c. Remove the Dialogic System Software. 

i. Locate the Add/Remove Programs from the Windows Control Panel (Start > Settings > Control Panel 

> Add/Remove Programs). 
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ii. Select and Remove the Dialogic software. 

d. Reboot the system as indicated. 

2. In rare instances, you might need to run a Dialogic utility to clean up the old Dialogic Release 5.1.1 installation 

files, directories, and registry settings. This batch file can be located in \cleanup\dlgc_rel_clean.bat in 

the Dialogic installation directory. This will be apparent if the Dialogic DCM – configuration management 

application is not installed. 

3. Install the Dialogic System Software. 

a. Follow the procedure in the previous section (New Installation of Dialogic Software) to install the required 

version of Dialogic applicable to your PBX. 

4. Launch the Microsoft® Windows Service control application (Start > Settings > Control Panel > 

Administrative Tools > Services). 

a. Set the Startup type to Automatic for the service labeled ADTRAN NetVanta UC Server Application 

Services. 

6.2 Software Product Interoperability 

The following other software products have been tested and are known to work with NetVanta UC Server: 

Vendor Interoperability  

Level 

Product/Service Software Version 

Research In Motion 

(RIM) 

Interoperable BlackBerry Enterprise Server 

for Microsoft Exchange 

4.1 or newer 

BlackBerry Handheld Devices 4.2.1 rev 163, 4.2.2 or newer 

PhoneTag Interoperable PhoneTag 

(formerly SimulScribe) 

n/a 

Google Interoperable Google Mail (Gmail)  

using stunnel (SSL proxy) 

n/a 

stunnel 4.24 

7 Known Software Limitations 

The following limitations are known in this NetVanta UC Server release: 

Tracking # ISSUE Workaround 

4325 Silent Installation of NetVanta ucCompanion – Live 

Attendant (installation fails using command line 

with parameters: /S /v /qn) 

Use Install Wizard  
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Tracking # ISSUE Workaround 

4503 NetVanta UC Server implementations on a 

Microsoft Windows Small Business Server (SBS) 

will not be able to view voice or fax messages from 

the local machine or through the terminal services 

client connected to the same Small Business 

Server. The Microsoft MAPI version that is installed 

with Microsoft Exchange Server does not support 

the same capabilities as the MAPI driver that is 

installed with Microsoft Outlook. Installing Outlook 

on the SBS server will not resolve this issue, nor is it 

supported by Microsoft. 

None. This is not a supported deployment 

scenario. 

4614 There is currently a known issue with the Windows 

Installer on Windows Vista platforms.  During 

uninstall of NetVanta UC Server, the User Account 

Control dialog box indicates that the publisher is 

unidentified. This issue is caused when the 

Windows Installer caches a copy of the MSI 

package in the Installer folder during the 

installation process. Windows Installer removes 

some data from the cached copy of the MSI in an 

effort to reduce the size consumed by the copied 

MSI. As a result, the embedded digital signature 

becomes invalid. 

Accept the warning and continue. 

5020 Call Swap on NetVanta ucCompanion – Live 

Attendant is not supported. 

None. 

5124 On Windows Vista, the fax printer driver will not 

successfully execute if NetVanta UC Client is 

installed by either the administrator or by a user 

that has used the Run as administrator option.  

Note that this scenario does not apply to a user 

installing NetVanta UC Client that has elevated 

their privileges to administrator to install NetVanta 

UC Client. 

In both cases, after installing NetVanta UC 

Client it will be necessary to log out and log 

back in to Windows (as the appropriate user).   

5204 On Windows Vista, the fax printer driver will not 

successfully execute if NetVanta UC Client is first 

launched directly from Outlook or by running the 

executable directly from the bin folder. 

The first time that NetVanta UC Client is run 

it must be launched from the Start Menu. 

5571 Three-way conference initiators do not pass DTMF 

tones generated by conference participants. 

Have the conference initiator generate the 

DTMF tones. 
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Tracking # ISSUE Workaround 

5742 Windows services automatic recovery processes 

hinder diagnosis of any startup issue and could 

result in unnecessary entries added to the system 

or application event logs. 

Ensure the recovery settings for the ADTRAN 

NetVanta UC Server Application Services 

service are set to Take no Action in all cases 

(first failure, second failure, and subsequent 

failures). These settings should not be 

changed.   

5859 Minor noncompliance related to Request URI in 

ACK and BYE SIP Messages under very specific 

circumstances involving specialized equipment.  

ECS, BAS  

None. 

5862 Incorrect call status displayed on NetVanta 

ucCompanion – Live Attendant UI occurs 

infrequently and then usually only on low end or 

overloaded systems and immediately after an 

installation. 

Restart the ADTRAN NetVanta UC Server 

SIM service in the Services control panel.  

5878 Windows XP and Windows Server 2003 system 

performance – Indexing service uses a large 

amount of page file space (larger than 1.2 GB) and 

CPU time. 

Turn off the Windows Indexing Service. Refer 

to the NetVanta UC Server installation 

manual for instructions. 

5966 Creating a UC user from within Active Directory, it 

is possible to neglect creating an associated 

identity at the same time. This has the side effect 

of not creating a temporary PIN for the user. 

The administrator can explicitly set the PIN 

from within the AD pages. 

6073 Service account password is not preserved on 

upgrade from 4.0.x to 4.2.x if the current account 

option is selected in the Select Service Account 

dialog box. This specifies that the currently 

configured service is to be used as the service login 

account. If selected, the ADTRAN NetVanta UC 

Server Application Service will fail to restart.  

The upgrade instructions included in this 

document describe the necessary steps to 

restore the service account. Please ensure 

you follow these instructions. 

6256 On an upgrade from pre 4.2.1, the NetVanta 

ucCompanion – Live Attendant Calls menu does 

not automatically use the new shortcuts as 

described in the documentation.  ECS, BAS  

The Calls menu shortcut assignments are 

customizable, so to preserve these custom 

settings, the new shortcut mappings are not 

automatically registered. To manually reset 

the shortcuts to the new mappings, perform 

the following action: Within the View menu 

select Toolbars >, then Customize…. In the 

Customize dialog box, select the Keyboard 

tab then click the Reset All button. 

6614 In some cases, caller information might not be 

received in distributed IP Office TAPI integrations. 

None. 
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Tracking # ISSUE Workaround 

6797 Uninstalling NetVanta UC Server from Windows 

Server 2008 does not automatically stop the 

OBJECTWORLD instance of SQL Server. 

After uninstalling NetVanta UC Server, 

manually stop the OBJECTWORLD SQL 

Server Express service, and then manually 

uninstall the OBJECTWORLD SQL Server 

Express instance. 

6978 After upgrade to Windows Vista Service Pack 1, UC 

Server MMC plug-in is no longer available. 

Reinstalling NetVanta UC Client does not resolve 

the problem. 

Reinstalling the Microsoft’s Windows Server 

Administration Tools will resolve the 

problem. 

7074 Fax printer driver cannot send faxes when My 

Documents folder is redirected to network share. 

This appears to be an issue with the 

Microsoft Universal Printer driver supplied in 

Windows Vista and used by the Fax Printer 

Driver. The workaround is to disable My 

Documents redirection. 

7376 Sending faxes to the Fax Printer Driver in A4 

format causes the fax document to be generated 

incorrectly and the fax will fail to be sent. 

Print using letter format instead. 

7700 AMD systems running Windows Server 2003 or 

Windows XP can experience choppy or corrupt 

audio with some phones. 

Follow instructions in Microsoft KB article 

895980: 

http://support.microsoft.com/kb/895980 

8149 Active Message Delivery can fail when all ports on 

an Avaya IP Office are busy. 

Increase the number of ports to improve port 

availability. 

8282 On Windows XP, the service account used for the 

Application Services can spontaneously become 

lost or invalid. This can occur when the system is 

restarted, the ADTRAN NetVanta UC Server 

Application Services service is restarted, or the 

NetVanta UC Server software is upgraded (causing 

a 1920 error). 

Use Windows Server-based platforms instead 

of Windows XP. Additional instructions have 

been added to upgrade procedure to 

mitigate the 1920 problem during upgrade 

caused by this issue. 

8374 snom phones do not register on networks with 

spanning tree enabled. Consult snom support 

material for more details. 

Enable fast spanning tree or disable spanning 

tree on the network. Consult snom support 

material for more details. 

8659 No click-to-dial context menu is provided on 

Outlook 2003 email messages. 

Upgrade to Outlook 2007. 

8685 Outlook 2003 plug-in still installed and cannot be 

removed after upgrading Outlook to 2007 version. 

Uninstall NetVanta UC Client software before 

upgrading Outlook and reinstall after 

upgrading. 

8803 Microsoft Live Search Maps add-in for Microsoft 

Outlook causes problems with NetVanta UC plug-

ins. 

Uninstall Microsoft Live Search Maps add-in. 

Refer to 

http://support.microsoft.com/kb/961081 for 

more details. 

http://support.microsoft.com/kb/895980
http://wiki.snom.com/FAQ/Why_is_the_registration_delayed_when_the_phone_is_attached_to_a_manageable_switch
http://wiki.snom.com/FAQ/Why_is_the_registration_delayed_when_the_phone_is_attached_to_a_manageable_switch
http://wiki.snom.com/FAQ/Why_is_the_registration_delayed_when_the_phone_is_attached_to_a_manageable_switch
http://wiki.snom.com/FAQ/Why_is_the_registration_delayed_when_the_phone_is_attached_to_a_manageable_switch
http://support.microsoft.com/kb/961081
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Tracking # ISSUE Workaround 

8904 On systems with User Account Control (UAC) 

enabled, batch files, such as the scripts to stop, 

start and restart all NetVanta UC Server services, 

need to be run with administrative privileges. 

Right click on the scripts, and select Run as 

administrator from the context menu. 

Alternatively, start a command prompt in the 

same manner and invoke the scripts from the 

command prompt. Refer to Microsoft 

product documentation on UAC for more 

details. 

8946 While installing UC Server, the install fails with 

error 1718. The log file reports that an MSI file was 

rejected by digital signature policy. 

This problem occurs if the Windows Installer 

process has insufficient contiguous virtual 

memory to verify that the installation 

package is correctly signed.  Refer to 

http://support.microsoft.com/kb/925336 for 

details on this issue and for a fix. 

 

http://support.microsoft.com/kb/925336

